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Preface

This document describes the OGC Web Coordinate Transformation Service (WCTYS)
operations.

Most geo-spatial data are stored in different coordinate reference systems (CRS). To
enable services to use data from different sources stored in different CRS each service
has to access a transformation service. At the moment each OGC web service has to
access its own transformation implementation or access a service via COM, CORBA or
RMI asdefined in ,, Coordinate Transformation Services | mplementation Specification*
(CTS) [5].

To offer the largest amount of interoperability and a standardized access to the
transformations of CRS in a general way through the inter-/intranet this specification

defines web service interfaces for performing transformations of geo-spatial data from
one CRS to another. WCTS is closely linked to the Geography Markup Language (GML)
Version 3 which describes an XML-encoding of geo-spatial data.

To do thisaWCTS shall be able to handle the following requests:

1. Which Geometry and Coverage types of GML3 are supported?

2. Which CRSs are known by the WCTS as source and target CRS of a
transformation?

3. Which transformations are known by the WCTS? This is a necessary information
because in many cases there exists more than one way to transform coordinates
from one CRS to another.

4. 1sthe WCTS capable to use user defined CRS and/or transformations?

5. Isthe transformation between two sets of data with spedifict CRS possible?

6. Which ‘transfomation steps’ will be performed to transform a coordinate from
one CRS to another?

7. Performing a transformation from one CRS to another.

viii © OGC 2002 — All rights reserved
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Foreword
Attention is drawn to the possibility that some of the elements of this standard may be the

subject of patent rights. Open GIS Consortium Inc. shall not be held responsible for
identifying any or all such patent rights. However, to date, no such rights have been

claimed or identified.

This version of the specification cancels and replaces all previous versions.

Nor mative Annexes

Annexes A and B are normative.
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0 Introduction

Transformation of geo-spatial data from one CRS to another is a frequent requirement

when integrating data from different sources into one application process. But not all
applications —we believe most of them — are not capable to do this. The following use
cases demonstrate how a web based transformation service can solve this problem.

0.1 Use Cases (Informative)

This chapter describes several use cases that will clarify the requirementsto aWCTS and
thelr realisation within this specifications.

The base of all use casesis the following scenario:

There is amap to create that uses EPSG:4326 as CRS. The borders of the Federal
Republic of Germany (layer 1), the mgjor rivers of the Federal Republic of Germany
(layer 2) and the largest cities of the Federal Republic of Germany (layer 3) shall be
used. The borders of the Federal Republic of Germany are available in EPSG:31467
(Gaul3-Kruger band 3). The mgor rivers are stored in EPSG:4230 (International 1924)
and the largest cities in EPSG:23032 (UTM band 32)

0.11 Desktop Application

The term ,, Desktop Application” describes a Gl-application that is running stand-alone on
a PC and that accesses the data it uses through afile system. It is assumed that the
application is allowed to access a network (intra-/internet) where a WCTS is available. It
is also assumed that all layers defined within the scenario are available through alocal
data store.

Internet

Web Coordinate
Transformation
Srvice

application <

Y

Fig. 1 use case 1: application - WCTS interaction

The following steps have to be performed at this use case:
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1. The application defines a new map with the target CRS.

2. The application loads layer 1 and recognises that coordinates are not stored in
EPSG:4326.

3. The application connects the WCTS through the network and requests its
capabilities. Using the capabilities the application evaluates if a transformation
from EPSG:31467 to EPSG:4326 can be performed by the WCTS. (This can aso
be done by sending an IsTransformable request to the WCTYS).

4. The application sends the geo-spatial data assigned to layer 1 to the WCTS
requesting their transformation to EPSG:4326.

5. The WCTS sends the transformed data back to the application.
6. Steps2to 5 will be repeated for layer 2 and 3.
7. The application will render the map.

012 WMS

It is assumed that the map defined above will be requested by a client through a network

using avalid WMS request. Likein use case 1 it is aso assumed that all required data are
stored in independent sources that can be accessed by the WM S directly (integrated
WMS).

Internet Internet

Web Coordinate
Transformation
Service

client (browser)

WMS

A
Y
A
Y

Fig. 2 use case 2: WM S - WCTSinteraction

The sequence of steps to perform is similar to use case 1.

First, however, the client must inquire the WM S (Capabilities Request) whether it can
render the map in the desired coordinate reference system. Afterwards the map, as
described in use case 1, will be rendered and passed to the client (web browser) viathe
inter-/intranet.

required steps are:

© OGC 2002 — All rights reserved Xiii
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1. The client defines the parameters for a new map.
2. Theclient posts a GetMap request to aWMS.
3. The WMS states that the requested layer is not yet present in the correct CRS.

4. The WMS dready knows that the WCTS offers the necessary transformation; it
therefore sends the data of the first layer for transformation to the WCTS.

5. Step 4 will be repeated for layer 2 and 3.

6. The WMS renders the map and sends it back to the client (web browser)

0.1.3 Service Chain

The requirements correspond to those of use case 2; but the renderable data are not
offered directly by the WMS. Therefore the WM S must request them via the Internet
fromaWFS (= component WMYS). This supplies the data in the CRS specified above.

Internet Internet

Y
7

client (browser) WMS

A
Y
A

Web Coordinate
Transformation
Service

Y

Fig. 3usecase 3: WMS - WFS -WCTSinteraction

In this case the WMS sends a request to the WCTS, providing the input data as a
getFeature-Request for a specific WFS. The WCTS then sends this request to the WFS,
transforms the coordinates and sends those as respone to the WMS. The remaining steps
will be performed as described above.

In principle the model is expandable for further levels e.g. in the case of a cascading
WMS or aservice chain.

Xiv © OGC 2002 — All rights reserved
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Internet Internet

7

client (browser) WMS

A

A
Y

Y
g
<
wn

Internet

4

Web Coordinate
Transformation
Service

Y

Fig. 4 use case 3: servicechain

It must be considered that to the WM S addressed through the cascade already must

supply the requested Layer in the target CRS, since the transformation of a raster image
would be too expensive and the result possibly does not correspond to expectations (e.g.
by substantial distortions of the labeling).
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Web Coordinate Transfor mation Service | mplementation
Specification

1 Scope

This standard specifies the transformations of geospatial coordinates from one Coordinate
Reference System (CRS) into another by means of a Web Service. Frequently geospatial
data are accessible only in one coordinate references system. If geospatial data from
different sources shall be processed together thisis only possible if al relevant data are
available in the same reference system. If thisis not the case, the data must be
transformed into a uniform CRS.

Not each service and/or not each client possesses the ability to transform geo-spatial
coordinates from one CRS o another. In practice this makes the realisation of distributed,
interoperable Gl systems frequently more difficult or impossible.

This specification describes a Web Service based on the OGC CTS implementation [5]
specification, SO DIS 19111 [6] and Abstract Specification Topic 2 [7] which allows
applications and other Web Services to transform geospatial coordinates from one CRS
into another. Transformations shall both take place between CRS that are known by the
WCTS and between CRS, which are defined by the user (client).

This standard is applicable to al geospatial data which are encoded as GML 3 whichis
the current version of the GML standard.

2 Conformance

Conformance with this specification shall be checked using all the relevant tests specified
in Annex B (normetive). The framework, concepts, and methodology for testing, and the
criteriato be achieved to claim conformance are specified in 1SO 19105: Geographic
information — Conformance and Testing.

3 Normativereferences

[1] Fielding et. a., "Hypertext Transfer Protocol —HTTF/1.1," IETF RFC 2616, June
1999, http://www.ietf.org/rfc/rfc2616.txt.

[2] Bray, Hollander, Layman, eds., “Namespaces In XML”, January 1999,
W3CRecommendation, http://www.w3.org/TR/2000/REC -xml- names.

© OGC 2002 — All rights reserved 1
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[3] Bradner, Scott, "RFC 2119 Key words for use in RFCs to Indicate Requirement
Levels" March 1997, ftp://ftp.isi.edu/in-notes/rfc2119.txt.

[4] Percival, George, ed., “ The OpenGIS Abstract Specification, Topic 12: OpenGIS
Service Architecture”, 2002

[5] Daly, Martin (ed.), “OpenGI S Implementation Specification #01-009: Coordinate
Transformation Services. Revision 1.00, January 2001

[6] ISO/DIS 19111, Geographic Information — Spatial Referencing by Coordinates,
2000

[7]  Nicolai, Rod, ed., “The OpenGIS Abstract Specification, Topic 2: Spatia
Referencing by Coordinates’, 2002

[8] Whiteside, A. (ed.), “Recommended XML encoding of Coordinate Reference
System Definitions, OpenGI S Project document 02-036r3”, August 2002

4 Temsand definitions

4.1
operation
specification of atransformation or query that an object may be called to execute [4]

4.2

interface
anamed set of operations that characterise the behaviour of an entity [4]

4.3
service
adistinct part of the functionality that is provided by an entity through interfaces [4]

4.4
serviceinstance

an actual implementation of a service; service instance is synonymous with server

4.5
client
a software component that can invoke an operation from a server

4.6

request
an invocation by aclient of an operation.

2 © OGC 2002 — All rights reserved
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4.7
response
the result of an operation returned from a server to a client.

4.8

capabilities

service-level metadata describing the operations and content available at a service
instance

4.9
coordinate reference system

asdefined in [7]

5 Conventions

5.1 Normativeverbs

In the sections labeled as normative, the key words " must”, " must not", " required” ,
"shall", " shall not", " should", " should not", " recommended", " may", and
optional” in this document are to be interpreted as described in Internet RFC 2119 [§].

5.2 Abbreviated terms

API Application Program Interface

Cal Common Gateway Interface

COTS Commercial Off The Shelf

CRS Coordinate Reference System

CTS Coordinate Transformation Services
DCP Digtrib uted Computing Platform
EPSG European Petroleum Survey Group
GIS Geographic Information System
GML Geography Markup Language
HTTP Hypertext Transfer Protocol

ISO International Organization for Standardization

© OGC 2002 — All rights reserved 3
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KVP key-value pair

OGC Open GIS Consortium

RFC Request for Comments

URL Uniform Resource Locator

WCTS Web Coordinate Transformation Service
WMS Web Map Service

WFS Web Feature Service

WCS Web Coverage Service

XML eXtended Markup Language

6 Basic Service Elements

This section describes aspects of Web Coordinate Transformation Service behaviour that
are independent of particular operations or are common to several operations or
interfaces.

6.1 Version Numbering and Negotiation

6.1.1 Version Number Form

The published specification version number contains three positive integers, separated by
decima points, in the form "x.y.z". The numbers "y" and "z" will never exceed 99.

6.1.2 Version Changes

A particular specification's version number shall be changed with each revision. The
number shall increase monotonically and shall comprise no more than three integers
separated by decimal points, with the first integer being the most significant. There may
be gaps in the numerical sequence. Some numbers may denote experimental or interim
versions. Service instances and their clients need not support all defined versions, but
must obey the negotiation rules below.

6.1.3 Appearancein Requestsand in Service M etadata

The version number appears in at least two places. in the Capabilities XML describing a
service, and in the parameter list of client requests to that service. The version number
used in aclient's request of a particular service instance must be equal to aversion

number which that instance has declared it supports (except during negotiation as

4 © OGC 2002 — All rights reserved
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described below). A service instance may support several versions, whose values clients
may discover according to the negotiation rules.

6.1.4 Version Number Negotiation

A Client may negotiate with a Service Instance to determine a mutually agreeable
specification version. Negotiation is performed using the GetCapabilities operation
according to the following rules.

All Capabilities XML must include a protocol version number. In response to a
GetCapahilities request containing a version number, an OGC Web Service must either
respond with output that conforms to that version of the specification, or negotiate a
mutually agreeable version if the requested version is not implemented on the server. If
no version number is specified in the request, the server must respond with the highest
version it understands and label the response accordingly.

Version number negotiation occurs as follows:

1. If the server implements the requested version number, the server must send that
verson.

2. If the client request is for an unknown version greater than the lowest version that
the server understands, the server must send the highest version less than the
requested version.

3. If the client request is for a version lower than any of those known to the server,
then the server must send the lowest version it knows.

4. If the client does not understand the new version number sent by the server, it
may either cease communicating with the server or send a new request with a new
version number that the client does understand but which is less than that sent by
the server (if the server had responded with a lower version).

5. If the server had responded with a higher version (because the request was for a
version lower than any known to the server), and the client does not understand
the proposed higher version, then the client may send a new request with aversion
number higher than that sent by the server.

The process is repeated until a mutually understood version is reached, or until the client
determines that it will not or cannot communicate with that particular server.

6.2 General HTTP Request Rules

6.21 Introduction

At present, the only distributed computing platform (DCP) explicitly supported by OGC
Web Servicesis the World Wide Web itself, or more specifically Internet hosts
implementing the Hypertext Transfer Protocol (HTTP)[2]. Thus the Online Resource of

© OGC 2002 — All rights reserved 5
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each operation supported by a service instance is an HTTP Uniform Resource L ocator
(URL). The URL may be different for each operation, or the same, at the discretion of the
service provider. Each URL must conform to the descriptionin [2] but is otherwise
implementation-dependent; only the parameters comprising the service request itself are
mandated by the OGC Web Services specifications.

HTTP supports two request methods: GET and POST. One or both of these methods may
be defined for a particular OGC Web Service type and offered by a service instance, and
the use of the Online Resource URL differsin each case.

6.22 HTTP Get

An Online Resource URL intended for HTTP GET requestsisin fact only a URL prefix
to which additional parameters must be appended in order to construct avalid Operation
request. A URL prefix is defined as an opaque string including the protocol, hostname,
optional port number, path, a question mark *?, and, optionally, one or more server-
specific

parameters ending in an ampersand '&". The prefix uniquely identifies the particular
service instance. A client appends the necessary request parameters as name/value pairs
in the form "name=value&". The resulting URL must be valid according to the HTTP
Common Gateway |nterface (CGI) standard [7], which mandates the presence of '?
before the sequence of query parameters and the '& " between each parameter. As with all
CGil applications, the query URL is encoded [8] to protect special characters.

The URL prefix must end in either a*? (in the absence of additional server-specific
parameters) or a'&". In practice, however, Clients should be prepared to add a necessary
trailing '? or ‘&' before appending the Operation parameters defined in this specification
in order to construct a valid request URL.

Table 1 summarizes the components of an operation request URL.

Tablel A general OGC Web Service Request

URL Component Description

http://host[:port]/path?{ name[=value] &} URL prefix of service operation. [ ] denotesO or 1
occurrence of an optional part; {} denotes 0 or more
occurrences. The prefix is entirely at the discretion
of the service provider.

name=value& One or more standard request parameter name/value
pairs defined by an OGC Web Service. The actual
list of required and optional parameters is mandated
for each operation by the appropriate OWS
specification.

6 © OGC 2002 — Al rights reserved
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6.23 HTTPPost

An Online Resource URL intended for HTTP POST requests is a complete and valid
URL to which Clients transmit encoded requests in the body of the POST document. A
WCTS must not require additional parameters to be appended to the URL in order to
construct a valid target for the Operation request.

6.3 General HTTP Response Rules

Upon receiving a valid request, the service must send a response corresponding exactly
to the request as detailed in the appropriate specification. Only in the case of Version
Negotiation (described above) may the server offer a differing result. Upon receiving an
invalid request, the service must issue a Service Exception.

NOTE: Asapractical matter, in the WWW environment aclient should be prepared to receive either avalid result, or
nothing, or any other result. This is because the client may itself have formed a non-conforming reguest that
inadvertently triggered a reply by something other than an OGC Web Service, because the Service itself may be non
conforming, etc.

Response objects must be accompanied by the appropriate Multipurpose Internet Mail
Extensions (MIME) type [9] for that object.

Response objects should be accompanied by other HTTP entity headers as appropriate
and to the extent possible. In particular, the Expires and Last-Modified headers provide
important information for caching; Content- Length may be used by clients to know when
data transmission is complete and to efficiently allocate space for results, and Content-
Encoding or Content- Transfer-Encoding may be necessary for proper interpretation of the
results.

6.4 Reguest Encoding

This document defines two methods of encoding WCTS requests. The first uses XML as
the encoding language. The second method uses keyword-value pairs to encode the
various parameters of areguest. An example of a keyword value pair is:

" REQUEST=Cet Capabi l i ties"

where "REQUEST" is the keyword and "GETCAPABILITITES' is the value. In both
cases, the response to a request or exception reporting must be identical. Table 2
correlates WCTS operations and their encoding semantics as defined in this specification.

Table 2 Operation Request Encoding
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Operation Request Encoding
GetCapabilities XML & KVP
DescribeTransformation XML & limited KVP
IsTransformable XML & limited KVP
Transform XML & limited KVP

The KVPs may include XML elements. Thisis for example the case when encoding a

Transform request. The geo-spatial data that shall be transformed may be encoded as
GML. If so the GML must be URL-encoded to uses it within a HTTP-GET request.

6.5 Namespaces

Namespaces [3] are used to distinguish the definitions of features and properties defined
in application specific domains from one another, and from the core constructs defined in
the GML and WCTS modules. A WCTS must be able to ingest and properly discriminate
XML input elements tagged with namespaces and must generate proper XML & GML,

correctly tagged with namespaces, so that the output validates against the various
schemas mandated by this document..

7 Common Elements

7.1 Exceptions

Upon receiving an invalid request, the service must issue a Service Exception XML
message to describe to the client application or its human user the reason(s) that the
request is invalid.

Service Exception XML must be valid according to the Service Exception Schema
definition in Annex A.3. In an HTTP environment, the MIME type of the returned XML
must be "appl i cation/vnd. ogc. se_xm "

The following Schema fragment shows the structure of an exception:

<!—- s e T s s s s s s s s s s s s s s s s s s s s s s s s s s >
<k- element definitions >
<!—— s s s s s s s pupupupepp—p—p—_—_—_—> ]
<xs:element name ="Exception" type ="ExceptionType"/>

<!—— s s s s s s s e e s pep——_—_—_—> ]
<! type definitions >
<!—— e s s s s s s s e e s e———— > ]

<xs:complexType name="ExceptionType">
<xs:sequence>
<xs:element name="Message" type ="xs:string"/>
<xs:element name="Location" type ="xs:string"/>
</xs:sequence>
</xs:complexType>
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7.2 XML dementsand attributes

There are a number of elements and attributes that are used by several requests and
responses. The full XML schema definition of these elements can be found in A.2. These
schemas make use of GML 3 schemas for features, geometry, coordinate reference
systems and coordinate operations.

The following elements use definitions of these external schemas and are part of the basic
definitions:

<xs:element name ="SourceCRS" type="wcts:CRSType"/>
<xs:element name ="TargetCRS" type="wcts:CRSType"/>
<xs:element name ="OnlineResource" type="wcts:OnlineResourceType'/>

<!—- s e T s s s s s s s s s s s s s s s s s s s s s s s s s s -->
<k- type definitions -->
<!—- s s s s s s s pupupupepp—p—p—_—_—_—> ]

<l- coordinate reference system of the data to be transformed -->
<xs:complexType name="CRSType">
<xs:sequence>
<xs:element ref="gml:_CoordinateRef erenceSystem"/>
</xs:sequence>
</xs:complexType>
M On”neResOurCeType ================= -->
<xs:complexType name="OnlineResourceType">
<xs:attribute name="xmins" type ="xs:string" fixed ="http://www.w3.0rg/1999/xlink"/>
<xs:attribute name="type" type="xs:string" fixed="simple"/>
<xs:attribute name="href" type="xs:string"/>
</xs:complexType>

721 Geometry, Coverage and I nterpolation typs.

The following schema fragment describes the geometric primitives, the coverage types
and the interpolation methods a WCTS may support.

<l--Types of Geometric Primitives in GML 3-->
<xs:simpleType name="GeometricPrimitiveTypeType">
<xs:restriction base="xs:string">
<xs:enumeration value="PointType"/>
<xs:enumeration value="LineStringType"/>
<xs:enumeration value="PolygonType"/>
<xs:enumeration value ="LinearRingType"/>
<xs:enumeration value="CurveType'"/>
<xs:enumeration value="LineStringSegmentType&'/>
<xs:enumeration value="ArcStringType"/>
<xs:enumeration value="ArcType"/>
<xs:enumeration value="CircleType"/>
<xs:enumeration value ="ArcStringByBulgeType"/>
<xs:enumeration value="ArcByBulgeType"/>
<xs:enumeration value="ArcByCenterPointType"/>
<xs:enumeration value="CircleByCenterPointType"/>
<xs:enumeration value="CubicSplineType"/>
<xs:enumeration value="BSplineType"/>
<xs:enumeration value ="BezierType"/>
<xs:enumeration value="OrientableCurveType"/>
<xs:enumeration value ="SurfaceType"/>
<xs:enumeration value="PolygonPatchType"/>
<xs:enumeration value="TriangleType"/>
<xs:enumeration value="RectangleType"/>
<xs:enumeration value="RingType"/>
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<xs:enumeration value="OrientableSurfaceType"/>
<xs:enumeration value="SolidType"/>
<xs:enumeration value="CompositeCurveType"/>
<xs:enumeration value="CompositeSurfaceType"/>
<xs:enumeration value="CompositeSolidType"/>
</xs:restriction>
</xs:simpleType>
<lL-Types of (referenced) Coverages in GML 3-->
<xs:simpleType name="CoverageTypeType">
<xs:restriction base="xs:string">
<xs:enumeration value="MulitPointCoverageType"/>
<xs:enumeration value ="MulitSurfaceCoverageType"/>
<xs:enumeration value="RectifiedGridCoverageType"/>
</xs:restriction>
</xs:simpleType>
<l- methods for interpolating coverages after they have been transformed-->
<xs:simpleType name="CoveragelnterpolationMethodType">
<xs:restriction base="xs:string">
<xs:enumeration value="nearest neighbor"/>
<xs:enumeration value="linear"/>
<xs:enumeration value="bilinear"/>
<xs:enumeration value="bicubic"/>
<xs:enumeration value="lost area"/>
<xs:enumeration value ="barycentric"/>
<xs:enumeration value ="piecewise constant"/>
<xs:enumeration value="none"/>
</xs:restriction>
</xs:simpleType>

8 GetCapabilities Operation (required)
8.1 Introduction

The web coordinate transformation service must have the ability to describe its
capabilities. This section defines an XML document that a web coordinate transformation
server must generate to define its capabilities.

The capabilities document defined in this specification is closely modeled after the
capabilities document defined for web map servers and web feature servers as described
in the Web Map Service Implementation Specification [9] and the Web Feature Service
Implementation Specification [10].

8.2 Request

821 KeyValue pair encoding

The general form of a GetCapabilities request is summarized in Table 1 below.

Table3 — The parameters of a GetCapabilities request URL

Request Parameter Required/ Description
Optional
REQUEST=GetCapabilities R Request name
VERSION=version 0] Request version
SERVICE=WCTS R Service type
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When making this request to a WCTS server, which may offer other OGC Web Services
as well, it is necessary to indicate that the client seeks information about the WCTS

server in particular. Thus, the SERVICE parameter of the request must have the vaue
"WCTS" asshown in Table3.

822 XML encoding

The <GetCapabilities> element is used to request a capabilities document from a web
coordinate transformation server.

<!—— L L L L L L L L L L L L L L L L L L L L L L L L L L L L L L oo oo e >
<l-- element definition ->
<!-- e p— -->

<lk- root element of a transform request -->
<xs:element name ="GetCapabilities" type ="wcts:GetCapabilitiesType"/>

<!—— e —————————————————————>
<! type definitions >
<!—— s>

<xs:complexType name ="GetCapabilitiesType ">
<xs:attribute name="version' type="xs:string" use="optional" fixed="0.1.0"/>
<xs:attribute name="service' type="xs:string" use="optional" fixed="WCTS"/>
</xs:complexType>

Thetop-level XML element, GetCapabilities, has two attributes, ver sion and service,
denoting, respectively, the version number of the protocol and the service it addresses.

8.3 Response
831 Response Schema

The schema of the response to a GetCapabilities request is normatively defined using
XML Schemain Annex A.5.

83.2 CapabilitiesDocument
The capabilities document is composed of two sections:

1. Service Section
The service section provides information about the service itself.

2. Capabilities Section
The capabilities section specifies the list of requests that the WCTS can handle.
Besides the mandatory operations GetCapabilities IsTransformable and
Transform the optional operation DescribeTransfor mation can be described in
the <Request> section.

Any WCTS has to know at least one coordinate transformation and two coordinate
reference systems so that it is able to perform one operation. The known transformations
and reference systems are defined in <K nownTransformation> and

<K nownCoor dinateRefer enceSystem>. Transformations refer to general methods for
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transformation of coordinates from one reference system into another and not the precise
transformations between two particular reference systems. Examples for transformtion

types are: longitude rotation, abridged Molodenski, geocentric to ellipsoid etc.

As GML 3 defines a vide spectrum of geometriesit is not mandatory for aWCTS to
support all those different kinds of geometries. Many WCTS will only need to support
“simple’” geometries as they were defined in GML 2. Others will not want to support all
of the possible curve and surface interpolations available in GML 3 or are not interested
in 3D geometries. The <SupportedGeometricPromitiveTypes> element alowsto
specify the geometric primites the WCTS is able to support. It is assumed, that aWCTS
has the ability to work with the corresponding geometric complexes and aggregates. The
<SupportedCoverageT ypeElement> describes the types of GML 3 coverages the
WCTS s able to handle. In the case of coverages which use specific geometric
primitives, acliert would have to check if the corresponding primitive types and
coverage types are supported. The <SupportedCover agel nter polation> elements give
information about the interpolation methods the WCTS is able to handle in case an
interpolation is necessary (as for transformation of rectified grids).

8.4 Exceptions

In the event that the web coordinate transformation server encounters an error servicing a
GetCapabilities request, it shall raise an exception as described in Section 7.1 above.

85 Examples

This example shows what a capabilities document might look like for a basic web

coordinate transformation server. To request a capabilities document, a client would
issue the following request:

<GetCapabilities version="0.1.0" service="WCTS"/>

In response to such a request, the web coordinate transformation server might generate a
document that looks like:

<?xml version="1.0" encoding="is0-8859-1"?>
<WCTS_Capabilities xmIns="http://schemas.opengis.net/wcts" xmIns:wcts="http://schemas.opengis.net/wcts"
xmins:gml="http://www.opengis.net/gml" xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://schemas.opengis.net/wcts
./GetCapabilitiesResponse.xsd" version="0.1.0" updateSequence="1">
<Service>
<Name>WCT S</Name >
<Title>Web Coordinate Transformation Service</Title>
<Abstract>Service for transformaing coordinates from one CRS to another through a network</Abstract>
<KeywordList>
<Keyword>Coordinate Reference System</Keyword>
<Keyword>transformation</Keyword>
</KeywordList>
<OnlineResource/>
<ContactInformation>
<ContactPersonPrimary>
<ContactPerson>Andreas Poth</ContactPerson>
<ContactOrganization >lat/lon</ContactOrganization>
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</ContactPersonPrimary>
<ContactPosition>Senior Software Engineer</ContactPosition>
<ContactAddress>
<AddressType >postal</AddressType >
<Address>Meckenheimer Allee 176</Address>
<City >Bonn</City>
<StateOrProvince>NRW</StateOrProvince>
<PostCode>53115</PostCode >
<Country>Germany</Country>
</ContactAddress>
<ContactVoiceTelephone>++49 228 732838 </ContactVoiceTelephone >
<ContactFacsimileTelephone>++49 228 732153</ContactFacsimileTelephone >
<ContactElectronicMailAddress >poth@Iat-lon.de</ContactElectronicMailAddress>
</ContactInformation>
<Fees>none</Fees>
<AccessConstraints>none </AccessConstraints>
</Service>
<Capability userDefinedCoordinateSystems ='false" userDefinedTransformations="false">
<Request>
<GetCapabilities>
<Format>String</Format>
<DCPType>
<HTTP>
<Get>
<OnlineResource xmlns:xlink="http://www.w3.0rg/1999/xlink " xlink:type ='simple"
xlink:href="ww.lat-lon.de/transform?'/>
</Get>
<Post>
<OnlineResource xmins:xlink="http://www.w3.0rg/1999/xlink " xlink:type ="simple"
xlink:href="ww.lat-lon.de/transform"/>
</Post>
</HTTP>
</DCPType>
</GetCapabilities>
<Transform>
<Format>String</Format>
<DCPType>
<HTTP>
<Post>
<OnlineResource xmins:xlink="http://www.w3.0rg/1999/xlink " xlink:type ="simple"
xlink:href="ww.lat-lon.de/transform"/>
</Post>
</HTTP>
</DCPType>
</Transform>
<IsTransformable>
<Format>String</Format>
<DCPType>
<HTTP>
<Post>
<OnlineResource xmiIns:xlink="http://www.w3.0rg/1999/xlink " xlink:type ="simple"
xlink:href="ww.lat-lon.de/transform"/>
</Post>
</HTTP>
</DCPType>
</IsTransformable>
<DescribeTransformation>
<Format>String</Format>
<DCPType>
<HTTP>
<Post>
<OnlineResource xmins:xlink="http://www.w3.0rg/1999/xlink " xlink:type ="simple"
xlink:href="ww.lat-lon.de/transform"/>
</Post>
</HTTP>
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</DCPType>
</DescribeTransformation>
</Request>
<SupportedTransformation>
<coordinateTransformation|D>
<gml:code>9601</gml:code >
<gml:codeSpace>EPSG</gml:codeSpace>
</coordinateTransformationID>
</SupportedTransformation>
<SupportedTransformation>
<coordinateTransformationI|D>
<gml:code>9602</gml:code >
<gml:codeSpace>EPSG</gml:codeSpace>
</coordinateTransformationID>
</SupportedTransformation>
<SupportedTransformation>
<coordinateTransformation|D>
<gml:code>9603</gml:code >
<gml:codeSpace>EPSG</gml:codeSpace>
</coordinateTransformationID>
</SupportedTransformation>
<SupportedTransformation>
<coordinateTransformation|D>
<gml:code>9604 </gml:code >
<gml:codeSpace>EPSG</gml:codeSpace>
</coordinateTransformationID>
</SupportedTransformation>
<SupportedTransformation>
<coordinateTransformation|D>
<gml:code>9807 </gml:code >
<gml:codeSpace>EPSG</gml:codeSpace>
</coordinateTransformationID>
</SupportedTransformation>
<SupportedCoordinateReferenceSysten
<crs|D>
<gml:code>4326</gml:code >
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</SupportedCoordinateReferenceSystenr
<SupportedCoordinateReferenceSystent>
<crsiD>
<gml:code>23031</gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</SupportedCoordinateReferenceSystent
<SupportedCoordinateReferenceSysten™
<crs|D>
<gml:code>23032</gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</SupportedCoordinateReferenceSystent
<SupportedCoordinateReferenceSystent>
<crsiD>
<gml:code>31467</gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</SupportedCoordinat eReferenceSystenr

<SupportedGeometricPrimitive Type >PointType</SupportedGeometricPrimitive Type>
<SupportedGeometricPrimitive Type >LineStringType</SupportedGeometricPrimitiveType >
<SupportedGeometricPrimitive Type >PolygonType</SupportedGeometricPrimitive Type>

</Capability >

</WCTS_Capabilities >

14
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9 IsTransformableOperation

9.1 Introduction

The I sTransformable request allows clients of the WCTS to check if atransformation of
as specific set of geomtries between two coordinate references systemsis possible. |t only
will be checked if the provided geometries are supported and if there is a valid way
(sequence of transformation steps) to transform the coordinates of one CRS to those of
another one. It will not be checked if this transformation makes any sense nor if it is
possible to be performed for each specific coordinate expression that may be submitted
by a Transform request.

In principle this information could be extracted from the capabilities of the WCTS as the
elements <Suppor tedGeometricPromitiveTypes>, <SupportedCover ageType>,
<SupportedCoveragel nteroplationType>, <KnownTransformation> and
<KnownCoor dinateRefer enceSystem> provide the necessary information. The analysis
of these elements in regard to the possibility of atransformation between two reference
systems for some specifict geometries or coverages is in some cases rather complicated
and would need powerful client logic. It seems to make more sense to provide this
information directly via a distinct operation, allowing simple clients to use the service.

9.2 Request

921 KeyValuepair encoding

Table4— The parameters of an IsTransformable request URL

Request Parameter Required/ Description
Optional

REQUEST=IsTransformable R Request name

VERSION=version 0] Request version

SOURCECRS R unique Identifier of the source
spatial reference system

DESTINATIONCRS R unique ldentifier of the destination
spatial reference system

GEOMETRICPRIMITIVETY PE 0] list of types of geometric primitives
that will be requested to be
transformed

COVERACETYPE 0] list of coverage types that will be
requested to be transformed

COVERAGEINTERPOLATIONM 0] interpolation Method which should

ETHOD be used

922 XML encoding

<k- element definitions >
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<k- root element of an IsTtransformable request -->

<xs:element name ="IsTransformable" type ='wcts:IsTransformaleType"/>

<kL- sub elements-->

<xs:element name ="GeometricPrimitiveType' type ="wcts:GeometricPrimitiveTypeType"/>
<xs:element name ='CoveragelnterpolationMethod" type="wcts:CoveragelnterpolationMethodType"/>
<xs:element name ="CoverageType" type="wcts:CoverageTypeType"/>

<!—- s p—————————————————————————————————————>
<lk- type definitions -->
<!—— e ———>

<xs:complexType name="IsTransformableType">
<xs:sequence>
<xs:element ref="wcts:SourceCRS"/>
<xs:element ref="wcts:TargetCRS"/>
<xs:element ref="wcts:GeometricPrimitiveType" minOccurs="0" maxOccurs="unbounded "/>
<xs:element ref="wcts:CoverageType" minOccurs="0" maxOccurs="unbounded"/>
<xs:element ref="wcts:CoveragelnterpolationMethod" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="version" type="xs:string" fixed="0.1.0"/>
</xs:complexType>

9.3 Response

The response to an IsTransformable request is a simple ‘true’ or ‘false’ depending on
whether the WCTS can perform the requested transformation.

<xs:element name ="TransformableResponse' type="wcts:TransformableResponseType"/>
<xs:complexType name ="TransformableResponseType">

<xs:attribute name="transformable"' type="xs:boolean' use="required"/>
</xs:complexType>

9.4 Exceptions

In the event that the web coordinate transformation server encounters an error servicing a
I sTransfor mable request, it shall raise an exception as described in Section 7.1 above.

9.5 Examples

951 IsTransformable Request

AnlsTransformable request for evaluating if a transformation between EPSG:4326 and
EPSG:23032 is possible will look like this:

<IsTransformable xmins ="http://schemas.opengis.net/wcts" xmins:xsi="http://www.w3.0rg/2001/XMLSchema -
instance" xmins:gml="http://www.opengis.net/gml" xsi:schemalLocation="http://schemas.opengis.net/wcts
JlsTransformableRequest.xsd™>
<SourceCRS>
<crs|D>
<gml:code>4326 </gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</SourceCRS>
<TargetCRS>
<crslD>
<gml:code>23032</gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
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</IsTransformable>

952 IsTransformable Response
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The servers response for the case that the transformation is possible looks like this:

<IsTransformableResponse isTransformable="true"/>

10 Transform Operation (required)

10.1 Introduction

The Transform operation is central to the web coordinate transformation server. It
allows the transformation of coordinates from one coordinate reference system into
another. Input data has to be provided as GML 3 Features, either in-line in the request, as
alink toaGML file or as a Request to a service providing the data. This can either be a
WFS or aWCS. Optionally the WCTS can support user-defined transformations which
make it necessary for the client to provide the parameters for the transformation

sequence.

10.2 Request

10.2.1 Key-Value pair encoding

Table5 — The parameters of a Transform request URL

Request Parameter Required/ Description
Optional

REQUEST=Transform R Reguest name

VERSION=version (0] Request version

SOURCECRS R unique Identifier of the source spatial reference
system

TARGETCRS R unigue Identifier of the target spatial reference
system

TRANSFORMATIONSEQUENCE 0] Sequence of transformation steps. Each step has
to be described in XML

DATA R The data that has to be transformed in GML 3 or

asreference/ WFS-request

Using aKey-Vaue pair encoding of a Transform request the number of the geometries
submitted with one request is limited to one if supplied in-line.
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10.2.2 XML encoding

The following schema fragment shows the structure of an XML encoded
request:

B e s e e

<lk- element definitions -->

<!—- e e e e e e e e e i

<lk- root element of an IsTransformable request -->

<xs:element name ="Transform" type ="wcts: TransformType"/>

<k- sub elements ->

<xs:element name ="Datd' type ="wcts:DataType"/>

<xs:element name ='RemoteOWS" type ="wcts:RemoteOWSType "/>
<xs:element name ="OWSRequest" type="wcts:OWSRequestType"/>
<xs:element name ="Service" type ="wcts:ServiceType'"/>
<xs:element name ="KVPRequest" type ="xs:string"/>

<xs:element name ="XMLRequest" type="xs:string"/>

<!—— s s s s s s s s s e pepep——_—_—_> ]
<lk- type definitions -->
<!-- e s s s s s e —p——————> ]

<xs:complexType name="TransformType">
<xs:sequence>
<xs:element ref="wcts:SourceCRS"/>
<xs:element ref="wcts:TargetCRS"/>
<xs:element ref="gml:_CoordinateOperation" minOccurs="0"/>
<xs:element ref="wcts:Data" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="version' type="xs:string" use="required" fixed="0.1.0"/>
</xs:complexType>
<xs:complexType name="DataType">
<xs:choice>
<xs:element name="FileURL"/>
<xs:element ref="gml:_Feature"/>
<xs:element ref="wcts:RemoteOWS"/>
</xs:choice>
</xs:complexType>
<xs:complexType name="RemoteOWSType">
<xs:annotation>
<xs:documentation >
A RemoteOWS gives a reference to a remote WFS/WCS/other-OWS server.
</xs:documentation>
</xs:annotation>
<xs:sequence>
<xs:element ref="wcts:OnlineResource"/>
<xs:element ref="wcts:OWSRequest'/>
</xs:sequence>
</xs:complexType>
<xs:complexType name="OWSRequestType">
<xs:choice>
<xs:element ref="wcts:KVPRequest'/>
<xs:element ref="wcts:XMLRequest'/>
</xs:choice>
</xs:complexType>
<xs:simpleType name="ServiceType">
<xs:restriction base="xs:string">
<xs:enumeration value="WFS"/>
<xs:enumeration value="WCS'"/>
</xs:restriction>
<Ixs:simpleType>

10.3 Response

The response to a Transform request isa GML 3 Feature.

18
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<!—- o o o o o o o o o o o o o o o e . e e e e e S S S S S S S S — —— —— —— —— —— — -->
<l-- element definitions -->
<!—— —e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e ——>

<k- root element of a transform response -->
<xs:element name ="TransformResponse" type="wcts:TransformResponseType"/>

<l- —=== === —=== —=== == ->
<lk- type definitions -->
<!—- o o o o o o o o o o o o o o o e . e e e e e S S S S S S S S — —— —— —— —— —— — -->

<xs:complexType name="TransformResponseTyp€e'>
<xs:sequence>
<xs:element ref="gml;_Feature" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>

10.4 Exceptions

In the event that the web coordinate transformation server encounters an error servicing a
Transform request, it shall raise an exception as described in Section 7.1 above.

105 Examples

10.5.1 Transform request

If aclient wants to transform a GML FeatureCollection from EPSG:2303 to EPSG:31467
using the default transformation steps it has to construct the following request:

<Transformxmins ="http://schemas.opengis.net/wcts" xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:gml="http://www.opengis.net/gml" version="0.1.0">
<SourceCRS>
<crsID>
<gml:code>23032</gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</SourceCRS>
<TargetCRS>
<crslD>
<gml:code>31467</gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</TargetCRS>
<Data>
<l here would be the description of a GML 3 FeatureCollection in EPSG: 23032 ...-->
</Data>
</Transform>

10.5.2 Transform response

As response to a request for transforming a LineString from EPSG:2303 to EPSG: 31467
the server will response — if no exception occurs — with:

<?xml version="1.0" encoding="UTF8"?>
<TransformResponse xmIns:gml|="http://www.opengis.net/gml" xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-
instance" >
<Data>
<k- ...and here would be the transformed FeatureCollection in EPSG:31467-->
</Data>
</TransformResponse>
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11 DescribeTransformation Operation (optional)

11.1 Introduction
Support of the DescribeT ransfor mation request is optional for a web coordinate
transformation server. It offers the description of a transformation from one coordinate

reference system into another. The WCTS DescribeTransformation request supplies the
steps which are necessary for the transformation. The response will be encoded as XML.

11.2 Request
11.2.1 Key-Value pair encoding

Table6 — The parameters of a DescribeTransformation request URL

Request Parameter Required/  Description
Optional

REQUEST= R Request name

DescribeTransformation

VERSION=version (@] Request version

SOURCECRS R unique Identifier of the source spatial reference
system

TARGETCRS R unique Identifier of the destination spatial reference
system

11.2.2 XML encoding

<le coooooooooooooooo oo oo oo oo oo oo oo oooooooomo s >
<k- element definitions >
Kle = e e e e e e e S

<l-root element of a transform request -->
<xs:element name ="DescribeTransformation' type ="wcts:DescribeTransformationType"/>
<kL- sub elements -->

<!—— e
<! type definitions >
<!-- oS oSS SIS ST ST ST S S S STSSSSISISITSISIT =D

<xs:complexType name ="DescribeTransformationType">
<xs:sequence>
<xs:element ref="wcts:SourceCRS"/>
<xs:element ref="wcts:TargetCRS"/>
</xs:sequence>
<xs:attribute name="version' type="xs:string" fixed="0.1.0"/>
</xs:complexType>

11.3 Response

As the transformation from one coordinate reference system to another cannnot usually
be done by a ssimple transformation, the transformation is described by its transformation
steps. One transformation step corresponds to a Transfor mation element as defined in
[8]. The number of transformation stepsis provided by the number Of Transfor mations

atribute.
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It is possible that a transformation is not feasable. Possible reasons for this are that the
web coordinat transformation service does not know the necessary transformation steps

or that atransformation is not possible at al (for example the transformation of a 3D to a
2D system). If atransformation is not feasable for a service WCTS returns an Exception.

A schema fragment describing the response to a DescribeT ransfor mation request
follows:

<!—— L L L L L L L L L L L L L L L L L L L L L L L L L L L L L L oo oo e —>
<lk- element definitions >
< !-- e -->

<lk-root element of a transform request -->
<xs:element name ="'DescribeTransformationResponse" type="wcts:DescribeTransformationResponseType"/>
<xs:element name ="CoordinateOperationID" type="gml:ExtendedldentifierType"/>

<!-- s>
<k- type definitions -->
<l-- i e

<l- response type -->
<xs:complexType name ="DescribeTransformationResponseType">
<xs:sequence>
<xs:element ref="wcts:CoordinateOperationI|D" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>

11.4 Exceptions

In the event that the web coordinate transformation server encounters an error servicing a
DescribeTransfor mation request, it shall raise an exception as described in Section 7.1
above.

11.5 Examples
11.5.1 DescribeTransformation request

A request for the description of a transformation might be encoded like this:

<?xml version="1.0" encoding="UTF~8"?>
<DescribeTransformation xmins="http://schemas.opengis.net/wcts "
xmins:wcts ="http://schemas.opengis.net/wcts ">
<SourceCRS>
<crsiD>
<gml:code>4326 </gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</SourceCRS>
<TargetCRS>
<crsiD>
<gml:code>31467</gml:code>
<gml:codeSpace>EPSG</gml:codeSpace>
</crsID>
</TargetCRS>
</DescribeTransformation>
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11.5.2 DescribeTransformation response

If no exception occurs the server will reply to a DescribeTransformation request with a
list of transformations. To transform EPSG:4326 to EPSG:31467 just one transformation
step is required.

<?xml version="1.0" encoding="UTF~8"?>
<DescribeTransformationResponse xmins="http://schemas.opengis.net/wcts"
xmins:wcts ="http://schemas.opengis.net/wcts " xmins:gml="http://www.opengis.net/gml" >
<CoordinateOperationID>
<gml:code>9807 </gml:code>
<gml:codeSpace>EPSG </gml:codeSpace>
</CoordinateOperationID>
</DescribeTransformationResponse>
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Annex A
(normative)

XML Schema definitions

A.1 Introduction

A.2 Basic Definitions

<?xml version="1.0" encoding="UTF8"?>
<xs:schema targetNamespace ="http://schemas.opengis.net/wcts "
xmlIns:xs="http://www.w3.0rg/2001/XMLSchema" xmIns:gml="http://www.opengis.net/gml|"
xmlns:wcts="http://schemas.opengis.net/wcts " xmins:xlink="http://www.w3.0rg/1999/xlink"
elementFormDefault="qualified" attributeFormDefault="unqualified">
<xs:import schemalocation ="../gml|3.0/base/coordinateReferenceSystems.xsd"/>
<xs:import schemalLocation ="../gml3.0/base/geometry.xsd'/>
<xs:import schemalocation ="../gml|3.0/xlink/xlinks.xsd"/>

<xs:element name ="SourceCRS" type="wcts:CRSType"/>
<xs:element name ="TargetCRS" type="wcts:CRSType"/>
<xs:element name ="OnlineResource" type="wcts:OnlineResourceType'/>

<!-- ) ey -->
<k- type definitions -->
<!—- o o o o o o o o o o o o o o o e . e e e e e S S S S S S S S — —— —— —— —— —— — -->

<l- defines the type for input and output format of a transform request. -->
<xs:complexType name="FormatType">
<xs:attribute name="name">
<xs:simpleType>
<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="GML"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
<lk- coordinate reference system of the data to be transformed -->
<xs:complexType name="CRSType">
<xs:sequence>
<xs:element name="crsID" type="gml:ExtendedldentifierType"/>
</xs:sequence>
</xs:complexType>
<h- cooooo—moooos On|ineResourceType Coooooooooooooomss o>
<xs:complexType name="OnlineResourceType">
<xs:attributeGroup ref="xlink:simpleLink'/>
</xs:complexType>
<kL-Types of Geometric Primitives in GML 3-->
<xs:simpleType name="GeometricPrimitiveTypeType">
<xs:restriction base="xs:string">
<xs:enumeration value="PointType"/>
<xs:enumeration value="LineStringType"/>
<xs:enumeration value="PolygonType"/>
<xs:enumeration value='"LinearRingType"/>
<xs:enumeration value="CurveType"/>
<xs:enumeration value="LineStringSegmentType'/>
<xs:enumeration value="ArcStringType"/>
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<xs:enumeration value="ArcType"/>
<xs:enumeration value="CircleType"/>
<xs:enumeration value ="ArcStringByBulgeType"/>
<xs:enumeration value="ArcByBulgeType"/>
<xs:enumeration value="ArcByCenterPointType"/>
<xs:enumeration value ="CircleByCenterPointType"/>
<xs:enumeration value="CubicSplineType"/>
<xs:enumeration value="BSplineType"/>
<xs:enumeration value="BezierType"/>
<xs:enumeration value="OrientableCurveType"/>
<xs:enumeration value="SurfaceType"/>
<xs:enumeration value="PolygonPatchType"/>
<xs:enumeration value="TriangleType"/>
<xs:enumeration value="RectangleType"/>
<xs:enumeration value="RingType"/>
<xs:enumeration value="OrientableSurfaceType"/>
<xs:enumeration value="SolidType"/>
<xs:enumeration value="CompositeCurveType"/>
<xs:enumeration value="CompositeSurfaceType"/>
<xs:enumeration value="CompositeSolidType"/>
</xs:restriction>
</xs:simpleType>
<k-Types of (referenced) Coverages in GML 3-->
<xs:simpleType name="CoverageTypeType">
<xs:restriction base="xs:string">
<xs:enumeration value ="MulitPointCoverageType"/>
<xs:enumeration value ="MulitSurfaceCoverageType"/>
<xs:enumeration value ="RectifiedGridCoverageType"/>
</xs:restriction>
</xs:simpleType>
<k- methods for interpolating coverages after they have been transformed-->
<xs:simpleType name="CoveragelnterpolationMethodType">
<xs:restriction base="xs:string">
<xs:enumeration value="nearest neighbor"/>
<xs:enumeration value="linear"'/>
<xs:enumeration value ="bilinear"/>
<xs:enumeration value="bicubic"/>
<xs:enumeration value="lost area'/>
<xs:enumeration value="barycentric"/>
<xs:enumeration value ="piecewise constant"/>
<xs:enumeration value="none"/>
</xs:restriction>
</xs:simpleType>
</xs:schema >
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A.3 Exception (Response)

<?xml version="1.0" encoding="UTF~8"?>
<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema" elementFormDefault="qualified"
attributeFormDefault="unqualified">

<l-- —==== e >
<lk- element definitions -->
<l-- ——=== ——=== ->
<xs:element name ='Exception" type ="ExceptionType"/>

<l-- ——=== ——=== -=>
<lk- type definitions -
<o === = == -->

<xs:complexType name="ExceptionType">
<xs:sequence>
<xs:element name="Message" type ="xs:string"/>
<xs:element name="Location" type ="xs:string"/>
</xs:sequence>
</xs:complexType>
</xs:schema >
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A.4 GetCapabilities Request

<?xml version="1.0" encoding="UTF~8"?>

<xs:schema targetNamespace ="http://schemas.opengis.net/wcts "
xmlns:xs="http://www.w3.0rg/2001/XMLSchema" xmins:wcts ="http://schemas.opengis.net/wcts"
elementFormDefault="qualified" attributeFormDefault="unqualified">

<l-- ——=== SSSS -—>
<k- element definition ->
<l-- ——=== ———=== -

<k- root element of a transform request -->
<xs:element name ="GetCapabilities" type ="wcts:GetCapabilitiesType"/>

<l-- —=—== ——o=== ->
<k- type definitions ->
<l-- ——=== SSSS -—>

<xs:complexType name ="GetCapabilitiesType ">
<xs:attribute name="version' type="xs:string" use="optional" fixed="0.1.0"/>
<xs:attribute name="service' type="xs:string" use="optional" fixed="WCTS"/>
</xs:complexType>
</xs:schema >
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A.5 Capabilities (Responseto GetCapabilities request)

<?xml version="1.0" encoding="UTF~8"?>
<xs:schema targetNamespace ="http://schemas.opengis.net/wcts "
xmlIns:xs="http://www.w3.0rg/2001/XMLSchema" xmIns:gml="http://www.opengis.net/gml|"
xmins:wcts ="http://schemas.opengis.net/wcts " elementFormDefault="qualified"
attributeFormDefault="unqualified">

<xs:import schemal.ocation ="WCTSCommon.xsd"/>

<xs:import schemalocation ="../gm|3.0/base/geometry.xsd'/>

< !-- e e ———————————————— -->
<lk- element definitions >
< !-- S e -->

<k- root element of a Capabilities response -->

<xs:element name ="WCTS_Capabilities " type="wcts:WCTS_CapabilitiesType"/>

<k- sub elements ->

<xs:element name ="Service" type ="wcts:ServiceType"/>

<xs:element name ="'Capability" type ='wcts:Capability Type "/>

<xs:element name ="Name" type="xs:string"/>

<xs:element name ="Title" type="xs:string"/>

<xs:element name ="Abstract" type="xs:string'/>

<xs:element name ="Format" type ="xs:string"/>

<xs:element name="DCPType" type="wcts:DCPTypeType"/>

<xs:element name="HTTP" type="wcts:HTTPType"/>

<xs:element name ="KeywordList" type="wcts:KeywordListType"/>

<xs:element name ="Keyword" type="xs:string"/>

<xs:element name ="'Contactinformation" type="wcts:ContactinformationType"/>

<xs:element name ="ContactPersonPrimary" type ="wcts:ContactPersonPrimaryType"/>

<xs:element name ="ContactPerson" type ="xs:string"/>

<xs:element name ="'ContactOrganization" type="xs:string"/>

<xs:element name ="'ContactPosition" type="xs:string "/>

<xs:element name ="ContactAddress" type ='wcts:ContactAddressType"/>

<xs:element name ="AddressType" type ="xs:string"/>

<xs:element name ='Address" type="xs:string'/>

<xs:element name ="City" type="xs:string"/>

<xs:element name ="StateOrProvince" type ="Xs:string"/>

<xs:element name ="PostCode" type ="xs:string"/>

<xs:element name ="Country" type="xs:string"/>

<xs:element name ="'ContactVoiceTelephone' type ='xs:string"/>

<xs:element name ="ContactFacsimileTelephone" type="xs:string"/>

<xs:element name ="ContactElectronicMailAddress" type="xs:string"/>

<xs:element name ="Fees" type ="xs:string"/>

<xs:element name ="AccessConstraints " type="xs:string"/>

<xs:element name ="Request" type="wcts:RequestType"/>

<xs:element name ="SupportedTransformation" type="wcts:SupportedTransformationType"/>

<xs:element name ='SupportedCoordinateReferenceSystem" type ="wcts:CRSTyp¢€'/>

<xs:element name ="SupportedGeometricPrimitiveType" type="wcts:GeometricPrimitiveTypeType"/>

<xs:element name ="SupportedCoverageType" type="wcts:CoverageTypeType"/>

<xs:element name ="SupportedCoveragelnterpolationMethod"
type="wcts:CoveragelnterpolationMethodType"/>

<!-- s s p————_—_ ]
<k- type definitions -->
<!-- s e T s s s s s s s s s s s s s s s s s s s s s s s s s s -->

<xs:complexType name="WCTS_CapabilitiesType">
<xs:sequence>
<xs:element ref="wcts:Service'/>
<xs:element ref="wcts:Capability"/>
</xs:sequence>
<xs:attribute name="version' type="xs:string"/>
<xs:attribute name="updateSequence" type="xs:string"/>
</xs:complexType>
<lk- ============== Service Type —================ -->
<xs:complexType name="ServiceType">
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<xs:sequence>
<xs:element ref="wcts:Name"/>
<xs:element ref="wcts:Title"/>
<xs:element ref="wcts:Abstract" minOccurs="0"/>
<xs:element ref="wcts:KeywordList' minOccurs="0"/>
<xs:element ref="wcts:OnlineResource"/>
<xs:element ref="wcts:Contactinformation"/>
<xs:element ref="wcts:Fees" minOccurs="0"/>
<xs:element ref="wcts:AccessConstraints" minOccurs="0"/>
</xs:sequence>
</xs:complexType>
N KeyWOrdListType oo ooooooooooss o>
<xs:complexType name="KeywordListType">
<xs:sequence>
<xs:element ref="wcts:Keyword" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>
N COntaCﬂnformationType —================ -->
<xs:complexType name="ContactinformationType">
<xs:sequence>
<xs:element ref="wcts:ContactPersonPrimary" minOccurs="0"/>
<xs:element ref="wcts:ContactPosition" minOccurs="0"/>
<xs:element ref="wcts:ContactAddress" minOccurs="0"/>
<xs:element ref="wcts:ContactVoiceTelephone" minOccurs="0"/>
<xs:element ref="wcts:ContactFacsimileTelephone" minOccurs="0"/>
<xs:element ref="wcts:ContactElectronicMailAddress" minOccurs="0"/>
</xs:sequence>
</xs:complexType>
<k- ============== ContactPersonPrimaryType === -->
<xs:complexType name="ContactPersonPrimaryType">
<xs:sequence>
<xs:element ref="wcts:ContactPerson"/>
<xs:element ref="wcts:ContactOrganization'/>
</xs:sequence>
</xs:complexType>
N Con[aCtAddressType ——= >
<xs:complexType name="ContactAddressType">
<xs:sequence>
<xs:element ref="wcts:AddressType"/>
<xs:element ref="wcts:Address"/>
<xs:element ref="wcts:City"/>
<xs:element ref="wcts:StateOrProvince"/>
<xs:element ref="wcts:PostCode"/>
<xs:element ref="wcts:Country"/>
</xs:sequence>
</xs:complexType>
A Capabmty Type ================= -->
<xs:complexType name="CapabilityType">
<xs:sequence>
<xs:element ref="wcts:Request"/>
<xs:element ref="wcts:SupportedTransformation" maxOccurs="unbounded'/>
<xs:element ref="wcts:SupportedCoordinateReferenceSystent minOccurs="2"
maxOccurs="unbounded"/>
<xs:element ref="wcts:SupportedGeometricPrimitiveType" maxOccurs="unbounded"/>
<xs:element ref="wcts:SupportedCoverageType" minOccurs="0" maxOccurs="unbounded"/>
<xs:element ref="wcts:SupportedCoveragelnterpolationMethod" minOccurs="0"
maxOccurs="unbounded"/>
<xs:element name="VendorSpecificCapabilities" type ="xs:string" minOccurs="0"
maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="userDefinedCoordinateSystems " type ="xs:boolean" default="false"/>
<xs:attribute name="userDefinedTransformations" type ="xs:boolean" default="false"/>
</xs:complexType>
M RequestType B S
<xs:complexType name ="RequestType">
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<xs:sequence>
<xs:element name="GetCapabilities" type ="wcts:ActionType"/>
<xs:element name="Transforni' type="wcts:ActionType"/>
<xs:element name="IsTransformablée' type="wcts:ActionType"/>
<xs:element name="DescribeTransformation" type ="wcts:ActionType" minOccurs="0"/>
</xs:sequence>
</xs:complexType>
At ACtionType = >
<xs:complexType name="ActionType">
<xs:sequence>
<xs:element ref="wcts:Format" maxOccurs="unbounded"/>
<xs:element ref="wcts:DCPType" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>
e DCPTypeType —================ -->
<xs:complexType name="DCPTypeType">
<xs:choice>
<xs:element ref="wcts:HTTP"/>
</xs:choice>
</xs:complexType>
<o s moommmome HTTPType EESS e
<xs:complexType name="HTTPType">
<xs:choice maxOccurs="unbounded">
<xs:element name="Post" type="wcts:AccessMethodType"/>
<xs:element name="Get" type="wcts:AccessMethodType"/>
</xs:choice>
</xs:complexType>
e AccessMethodType ——== >
<xs:complexType name ="AccessMethodType">
<xs:sequence>
<xs:element ref="wcts:Online Resource'/>
</xs:sequence>
</xs:complexType>
A KnownTranSformationType ================= -->
<xs:complexType name ="SupportedTransformationType">
<xs:sequence>
<xs:element name="coordinateTransformationID" type="gml:ExtendedIldentfierType"/>
</xs:sequence>
</xs:complexType>
</xs:schema >
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A.6 |IsTransformable Request

<?xml version="1.0" encoding="UTF~8"?>
<xs:schema targetNamespace ="http://schemas.opengis.net/wcts "
xmlns:xs="http://www.w3.0rg/2001/XMLSchema" xmins:wcts ="http:/schemas.opengis.net/wcts"
elementFormDefault="qualified" attributeFormDefault="unqualified">

<xs:import schemalocation ="WCTSCommon.xsd"/>

<!-- e p— -->
<lk- element definitions >
<!-- e e ———————————————— -->

<lk- root element of an IsTtransformable request -->

<xs:element name ="IsTransformable" type ="wcts:IsTransformableType"/>

<k- sub elements-->

<xs:element name ='GeometricPrimitive Typ€' type ="wcts:GeometricPrimitiveTypeType"/>
<xs:element name ="CoveragelnterpolationMethod" type="wcts:CoveragelnterpolationMethod Type"/>
<xs:element name ="CoverageType" type="wcts:CoverageTypeType"/>

<!-- e e ———————————————— -->
<k- type definitions -->
<!-- s>

<xs:complexType name="IsTransformableType">
<xs:sequence>
<xs:element ref="wcts:SourceCRS"/>
<xs:element ref="wcts:TargetCRS"/>
<xs:element ref="wcts:GeometricPrimitiveType" minOccurs="0" maxOccurs="unbounded "/>
<xs:element ref="wcts:CoverageType" minOccurs="0" maxOccurs="unbounded"/>
<xs:element ref="wcts:CoveragelnterpolationMethod" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="version' type="xs:string" fixed="0.1.0"/>
</xs:complexType>
</xs:schema >
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A.7 IsTransformable Response

<?xml version="1.0" encoding="UTF~8"?>

<xs:schema targetNamespace ="http://schemas.opengis.net/wcts "
xmlns:xs="http://www.w3.0rg/2001/XMLSchema" xmins:wcts ="http://schemas.opengis.net/wcts"
elementFormDefault="qualified" attributeFormDefault="unqualified">

<l-- ——=== SSSS -—>
<k- element definitions -->
<l-- ——=== ———=== -

<k- root element of a transformable response -->
<xs:element name ="IsTransformableResponse" type ="wcts:IsTransformableResponseType"/>

<l-- —=—== ——o=== ->
<k- type definitions -->
<l-- ——=== SSSS -—>

<lk- response type -->
<xs:complexType name="IsTransformableResponseType">
<xs:attribute name="isTransformable" type ="xs:boolean" use="required"/>
</xs:complexType>
</xs:schema >
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A.8 Transform Request

<?xml version="1.0" encoding="UTF~8"?>
<xs:schema targetNamespace ="http://schemas.opengis.net/wcts "
xmlIns:xs="http://www.w3.0rg/2001/XMLSchema" xmIns:gml="http://www.opengis.net/gml|"
xmins:wcts ="http://schemas.opengis.net/wcts " elementFormDefault="qualified"
attributeFormDefault="unqualified">

<xs:import schemalocation ="../gml|3.0/base/coordinateOperations.xsd'/>

<xs:import schemalLocation ="WCTSCommon.xsd"/>

<[-. [ —— f—— f—— f—— e ——— —===== -->
<k- element definitions -->
<h- oo oooooooooooooooooCooCooCooCooCooooooooooooooooooo oo o>

<k- root element of a transform request -->

<xs:element name ='Transform" type ="wcts:TransformType"/>

<k- sub elements ->

<xs:element name ="Datd' type ="wcts:DataType"/>

<xs:element name ="RemoteOWS" type ="wcts:RemoteOWSType "/>
<xs:element name ="OWSRequest' type="wcts:OWSRequestType"/>
<xs:element name ="Service" type ="wcts:ServiceType'"/>
<xs:element name ="KVPRequest" type ="xs:string"/>

<xs:element name ="XMLRequest" type="xs:string"/>

<!-- e p— -->
<lk- type defintions -->
<!-- e e ———————————————— -->

<xs:complexType name="TransformType">
<xs:sequence>
<xs:element ref="wcts:SourceCRS"/>
<xs:element ref="wcts:TargetCRS"/>
<xs:element ref="gml:_CoordinateOperation" minOccurs="0"/>
<xs:element ref="wcts:Data" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="version' type="xs:string" use="required" fixed="0.1.0"/>
</xs:complexType>
<xs:complexType name="DataType">
<xs:choice>
<xs:element name="FileURL"/>
<xs:element ref="gml:FeatureCollection"/>
<xs:element ref="wcts:RemoteOWS"/>
</xs:choice>
</xs:complexType>
<xs:complexType name="RemoteOWSType'>
<xs:annotation>
<xs:documentation >
A RemoteOWS gives a reference to a remote WFS/WCS/other-OWS server.
</xs:documentation>
</xs:annotation>
<xs:sequence>
<xs:element ref="wcts:OnlineResource"/>
<xs:element ref="wcts:OWSRequest'/>
</xs:sequence>
</xs:complexType>
<xs:complexType name="OWSRequestType">
<xs:choice>
<xs:element ref="wcts:KVPRequest'/>
<xs:element ref="wcts:XMLRequest'/>
</xs:choice>
</xs:complexType>
<xs:simpleType name="ServiceType">
<xs:restriction base="xs:string">
<xs:enumeration value="WFS"/>
<xs:enumeration value="WCS"/>
</xs:restriction>
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</xs:simpleType>
</xs:schema >
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A.9 Transform Response

<?xml version="1.0" encoding="UTF~8"?>
<xs:schema targetNamespace ="http://schemas.opengis.net/wcts " xmlIns:wcts="http://schemas.opengis.net/wcts"
xmlns:gml="http://www.opengis.net/gml" xmins:xs="http://www.w3.0rg/2001/XMLSchema "
elementFormDefault="qualified" attributeFormDefault="unqualified">

<xs:import schemalocation ="WCTSCommon.xsd"/>

<xs:import schemalocation ="../gml|3.0/base/feature.xsd"/>

<l-- ———=== ———=== -
<k- element definitions -->
<l-- === === >

<l- root element of a transform response -->
<xs:element name ="TransformResponse" type="wcts:TransformResponseType"/>

<l-- —o——== SSSS -—>
<k- type definitions -->
<l-- ———=== ———=== -

<xs:complexType name="TransformResponseTyp€e'>
<xs:sequence>
<xs:element ref="gml:_Feature" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>
</xs:schena>
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A.10 DescribeT ransfor mation Request

<?xml version="1.0" encoding="UTF~8"?>
<xs:schema targetNamespace ="http://schemas.opengis.net/wcts " xmlIns:wcts="http://schemas.opengis.net/wcts"
xmlns:xs="http://www.w3.0rg/2001/XMLSchema" elementFormDefault="qualified"
attributeFormDefault="unqualified">

<xs:import schemalocation ="WCTSCommon.xsd"/>

<l-- ———=== ———=== ->
<k- element definitions -->
<l-- ————== ————== -=>

<lk- root element of a transform request -->
<xs:element name ='DescribeTransformation' type ="wcts:DescribeTransformationType"/>
<k- sub elements ->

<l-- = o= S ]
<k- type definitions -->
<l-- ———=== ———=== -

<xs:complexType name="DescribeTransformationType">
<xs:sequence>
<xs:element ref="wcts:SourceCRS"/>
<xs:element ref="wcts:TargetCRS"/>
</xs:sequence>
<xs:attribute name="version' type="xs:string" fixed="0.1.0"/>
</xs:complexType>
</xs:schema >
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A.11 DescribeTransformation Response

<?xml version="1.0" encoding="UTF~8"?>

<xs:schema targetNamespace ="http://schemas.opengis.net/wcts " xmins:wcts="http://schemas.opengis.net/wcts"
xmins:gml="http://www.opengis.net/gml" xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
elementFormDefault="qualified" attributeFormDefault="unqualified">

<xs:import schemalocation ="../gml|3.0/base/coordinateOperations.xsd'/>

< !-- e p— -->
<l-- element definitions -
< !-- e e ———————————————— -->

<lk- root element of a transform request -->
<xs:element name ='DescribeTransformationResponse" type="wcts:DescribeTransformationResponseType"/>
<xs:element name ="CoordinateOperationID" type="gml:ExtendedldentifierType"/>

<!-- s e T s s s s s s s s s s s s s s s s s s s s s s s s s s -->
<k- type definitions -->
<!—- o o . . e o S e S e S S S S S S S S S — — —— ——— —— —— —— —— —— ——— —— —— — -->

<lk- response type -->
<xs:complexType name ="DescribeTransformationResponseType ">
<xs:sequence>
<xs:element ref="wcts:CoordinateOperationID" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>

</xs:schema >
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Annex B
(normative)

Conformance Test

B.1 Introduction

Specific conformance tests for Web Coordinate Transformation Service have not yet
been determined and will be added in a future revision of this specification.
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